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Everywhere and Rapidly Changing
The words quoted above from Dylan’s classic anthem of the sixties 
are as true today as they were when they were written! In the case 
of technology, they become truer with each passing year: products 
become outdated more and more quickly, as speed, memory and 
power double, and then double again – and then double again! It 
probably feels like yesterday when you bought that iPod and now it’s 
just a glorified paperweight. Although this feeling may sometimes be 
frustrating, it is a small price to pay when we consider where these 
rapid innovations have taken us. There is a reason that toddlers are 
as tech savvy as many adults – technology is easier to use than ever 
before! If you are someone who has avoided diving into it until now, 
you picked the best time to get started! Never has technology been 
more accessible.

With only a small investment of learning time, tech know-how can 
drastically simplify our lives, saving us countless hours and dollars. 
Before mentioning what it can do specifically for music teachers and 
musicians, let’s look at a few examples of how portable electronics 

VocaLsBass

TecHnoLogY
“   Come mothers and fathers throughout the land,
And don’t criticize what you can’t understand,
Your sons and your daughters are beyond your command,
Your old road is rapidly agin’,
Please get out of the new one if you can’t lend your hand,
For the times they are a-changin’.”
   -Bob Dylan (“The Times They Are A-Changin’” 1964)
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have revolutionized other aspects of modern life: With just a phone 
and our fingers, we can pay our bills, attend virtual work meetings, 
get a college degree, buy groceries to be delivered to our homes, 
find answers to many questions, pay for a cab, connect with anyone 
anywhere, create music and art, shop for anything, and find all kinds 
of entertainment.

Music in a Technological World
Students of all ages are using their devices to listen to and share 
music, view their favorite musical videos and performances, and to 
to compose, record, remix, and publish their own creations. Being 
able to make use of at least some of these production capabilities 
has become standard practice even among hobbyist music makers. 
Audio and video recording is now the first choice for documenting 
and communicating musical ideas and for many musicians, virtual 
instruments found in computer programs are taking the place of 
physical ones! What once required a complete recording studio with 
a vast array of instruments, years of study to be able to play each of 
those instruments, and thousands of dollars in labor rates, can now 
be done by any one person with a tablet, smartphone, or computer 
in every classroom in the country!

A New Classroom Experience
The instruments that make up the core of Modern Band (guitar, 
bass, drums, keyboard, vocals and computer) make it possible 
for you to structure your class in ways that cannot be done in 
traditional ensembles. By using the electric/electronic version of 
these instruments, students can all be playing in different mini-
groups at the same time, without interfering with each other. 
This is accomplished by either plugging into a module or device 
that has a headphone jack or attaching headphones to the actual 
instrument. This unique allowance for student-centered small group 
and individual playing among a full classroom of students with 
instruments is just not practical in a room containing 30 students 
playing brass, woodwind, bowed strings, and acoustic percussion.

Real World Relevance and the 
Tools Our Students Know 
By unlocking the capabilities of the tools already available to the vast 
majority of our students, we are empowering them to succeed far 
beyond the walls of our classrooms. It is important that we integrate 
technology into our practice so that the experiences we provide for 
our students in school will prepare them for the experiences they 
will encounter in their communities and in the world at large. Doing 
so also leverages a medium in which they are already fluent, feel 
comfortable, and to which they are attracted. In addition to the use 
of technology in the music room for recording and creating music, it 
can also completely transform the way you teach! 
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Three Types of Technology in 
the Modern Band Classroom

TECH FOR
RECORDING

Use technology to structure your classroom in amazing new ways, 
deliver all the audio and video content you could dream, acquire 
great instructional materials, and provide student access to 
interactive and educational websites and applications.

Use virtual and electronic instruments, samplers, loops, MIDI, 
backing tracks, and other digital technology to create music, or to 
act as invisible band mates! Computers are now legitimate members 
of many modern music groups, and often the centerpiece around 
which all else revolves!

Use technology to instantly document musical ideas and 
rehearsals, for evaluation and assessment, and to turn 
student compositions and performances into high quality 
productions!

TECH AS
INSTRUMENT

TECH AS
TEACHING TOOL

Tech as Teaching Tool

A World of Music and Video at Your Fingertips
As long as you have an Internet connection, hundreds of millions of 
songs and videos, both popular and obscure, are at your fingertips. 
You can access them in two ways  - downloading and streaming. 
Both have their benefits and limitations in relation to each other. 
However, both methods of acquiring and playing music are infinitely 
better than using CDs!

Say Goodbye to CDs
While DVDs contain a large amount of information that could 
be hard to “stream” or “download” without problems, CDs 
are quickly becoming obsolete. Apple has even discontinued 
offering CD drives on their laptop computers. Although you may 
enjoy collecting them, they will only waste the valuable time 
and space of which teachers always wish they had more. You 
can “rip” your CDs onto your computer using its CD drive and a 
program like iTunes or Windows Media Player. From iTunes, you 
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can transfer your music to your phone, tablet or iPod. For more 
information on how to do this, visit our “Tech Resources” section 
at littlekidsrock.org. 

Downloading – Yours To Keep
Downloading means to transfer a file from the web to your 
personal device, while uploading is to transfer from your device 
to the web. The main advantage of downloading a file compared 
to “streaming” (explained below) is that it becomes available 
for you to use without an internet connection. The downside 
of relying on a downloaded music and video collection is that it 
can quickly fill up your hard drive space, and you must always 
use the device on which the files are stored to play them. The 
most popular download sites are iTunes and Amazon. Some 
streaming sites like Spotify or Rhapsody allow downloading 
with a subscription. 

Streaming – Instant Access
Streaming means to instantly play a file without downloading it, 
directly from the website on which it is hosted. The advantage 
to this is instant access from any Internet enabled device and 
it doesn't require you to use any disk space. The downside is 
that without the Internet or a good Internet connection, you’re 
left with nothing! Popular streaming sites for video include 
YouTube, Netflix, Amazon Prime, Vimeo, TeacherTube, and 
many more. Popular streaming sites and apps for music include 
Spotify, Rhapsody, and Pandora. Each of these also has an 
app for your phone or tablet.

Using Streaming Music Sites in Your Classroom 
Spotify is the most popular free program or app that allows you 
to search and play millions of songs on demand! This includes 
everything from children’s songs and your friend’s self-released 
album to just about every title in your old CD collection and the 
latest top 40 chart toppers (visit spotify.com)! A $4.99 a month 
subscription removes the occasional ad and allows you to also 
download songs for offline playback! 

The implications of this for the classroom are revolutionary. 
These are a few:

❶  Your phone or device becomes the most extensive musical 
library in the world!

❷  No need to prepare your song selections as they are 
always at your fingertips.

❸  Listen to dozens of versions of the same song, comparing 
musical features and genres.

❹  Whenever your student mentions a song, you can play it 
within seconds, for reference.

❺  Allow students in small groups or individually to explore 
the music of an artist or genre, using any Internet enabled 
device, headphones and headphone splitters.
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Downloading Videos From YouTube 
For Offline Viewing
There are many ways to save streaming videos from YouTube and 
other sites to your computer for offline viewing. By doing so, you 
won’t have to rely on an erratic or non-existent Internet connection 
in school. One free and easy method explained below is the website 
keepvid.com. There are also a number of free apps and programs 
you can install to accomplish this task. Find them by doing a Google 
search for “download youtube video.”

How to Use KeepVid.com 
❶  Highlight and copy the web address (URL) of the YouTube 

video you want to download. 

❷  Go to www.keepvid.com and “paste” the web address into the 
URL space (Note: DO NOT click the big download button. It is 
an advertisement!)

❸  Click the grey download button and then download formats 
will appear. For Mac, right click on “MP4” and select Save As. 
For PC, simply click the download button and press allow if 
there are any warnings.

❹ Save to the desired folder. Once it finishes downloading, you  
     can open and play it. 

 

Downloading Audio From YouTube 
Videos for Offline Listening
YouTube is full of great songs, karaoke tracks, backing tracks and 
other recordings that you do not need a video to listen to. You can 
download the audio only to play offline using either keepVid.com 
or VidtoMp3.com. The latter website is more reliable. With keepVid.
com you will follow the same directions for downloading video but 
select mp3 instead of mp4.

This is an advertisement, do not click!

2

3
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How to Use VidtoMp3.com to Extract 
Audio from YouTube Videos:

❶  Copy the web address (URL) of the YouTube video you’d like to 
turn into an MP3, just like you did for keepvid.com.

❷  Go to VidToMP3.com and paste it into the “Enter Video URL 
Bar.”

❸ Click “download” and you will be taken to a new screen, where 
you should click the small letters that read “Click here to get 
you download link.”

❹  You’ll be taken to a third screen to click on your final download 
link.

Note: Do not click any of the big download buttons, which are 
advertisements, and avoid special offers. 

Slowing Songs Down, Changing 
Pitch and Looping Sections
By changing the pitch of a song, slowing it down, or looping small 
sections we can make it fit the needs of our students’ voices and 
technical ability. We can help them master a part by playing it 
over and over (looping). There are many apps and programs 
that specialize in these functions, both for iOS, Android, PC and 
Mac. Most of them have a free version with limited functionality. 
In addition to those below, you can use a free program called 
“Audacity,” which is explained in depth in the “Tech for Recording 
and Production” section.

Amazing Slow Downer - This is available for PC, 
Mac, Android and iOS. Each platform has a free 
version with limited functionality or a free trial. They 
have been improving their interface since the early 
2000s and the program is extremely simple to use! 
You can loop, transpose, speed up and slow down 
songs. You can then “Export” the song to a new file 
with the changes!

Anytune - This is a highly rated app for iOS that also 
loops, changes the speed, and changes the pitch of 
songs. It also allows you to export the modified file. 
There is a free version with limited functionality.

AudioSpeedChanger - This highly rated Android 
app has the same functions as the others, but does 
not allow you to export. You can save within the 
program.

2
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GAssistant
This free computer program is for Mac Only but 
makes slowing down, tempo change and looping a 
breeze!

Connecting your Phone, 
Computer, MP3 player, or Tablet 
to an Audio or Video Source
 
Connecting to a Guitar or Bass Amp
Most of the amps on the Little Kids Rock instrument menu (Mustang, 
Champion, Rumble) and almost all currently produced solid state 
amplifiers have a 3.5mm (1/8”) or RCA auxiliary audio input. These 
are meant to receive sound from the headphone jack of your device. 

Here are some examples:

❶ Mustang (3.5 mm aux) ❷ Rumble (RCA Audio) ❸ Champion (3.5 mm aux)

For example 1 above, you will need a 3.5mm (1/8”) stereo male to 
male audio cable, pictured below. Attach one end into your device, 
and the other to the amplifier and you’ve turned your amp into a 
powerful sound system!

For example 2, you will need a 3.5mm (1/8th in.) stereo male to RCA 
audio cable, pictured here. Attach one end to your device, and the 
other to your amplifier, and you’ve got an amplifier/sound system 
combo.
 
If your amp does not have an auxiliary input, you can use an 
auxiliary cable plus a 3.5mm (1/8”) stereo to 1/4” Mono converter 
on one end, and go straight into the instrument input! This is not 
recommended with tube amplifiers.

Going Wireless with Bluetooth or Wi-Fi! 
By making our devices wireless, they act as the remote control and 
the media player at the same time. We are free to move around 
the room without dragging a cable that someone can trip on! In a 



357For More Information Please Visit www.littlekidsrock.org

TE
C

H
N

O
LO

G
Y

Modern Band classroom, wires are everywhere and if we can get rid 
of a few of them, it can really help to simplify our lives! 

Connecting With Bluetooth
Bluetooth is a wireless technology used to exchange data over 
short distances. It is a standard feature on all new electronics 
including cell phones, computers, tablets and iPods. It allows you 
to pair your device with wireless Bluetooth speakers, Bluetooth 
receivers, wireless Bluetooth headphones or earpieces, and in 
your car. You can also use it to transfer files with nearby Bluetooth 
enabled devices. Visit littlekidsrock.org for a video demonstration of 
how to use this technology in the classroom.

Connecting with Wi-Fi
Just a few short years ago Wi-Fi was considered an unreliable way to 
at best send an emergency email! Now wired Internet has become 
the second choice and we can use Wi-Fi for all purposes, including 
playing music! 

Apple TV
Apple TV allows you to either wirelessly “mirror” your Apple 
device to an HDTV, projector or SMART board, or to wirelessly 
connect to an audio source to play music from your device! By 
using Apple TV in your classroom, every Apple device can be 
mirrored for your entire class to hear and see. It allows you to 
seamlessly switch between your computer, iPhone, iPod, iPad, 
and any Apple device that a student may be using as long as 
you are on the same wireless network. There is no time wasted 
between unplugging and re-plugging, and transitioning between 
devices takes seconds! Using the “audio out” jack on the Apple 
TV allows you to use it just for music and sound, bypassing the 
projector. For a demonstration of how to use this technology in 
the classroom, visit littlekidsrock.org.

Connecting a Phone or Tablet to a 
Projector or Visual Source
If you want your whole class to see or hear what you are doing on 
your iPad or Apple device, all you need is a simple adapter, often 
referred to as a “Dongle”. You plug one end into your device, and the 
other to the cable that goes into the projector or visual source.

❶  To connect an older iPad or apple device to a projector you will 
need an Apple Dock Connector to VGA adapter.

❷  To connect an older iPad or iPhone to an HDTV or HDMI input, 
you will need an Apple Dock Connector to HDMI adapter.

❸  To connect a newer iPad or iPhone to a projector, you will need 
an Apple Lightning to VGA adapter.

❹  To connect a newer iPad or iPhone to an HDTV or projector, 
you need an Apple Lightning to HDMI adapter.

Note: If you are using a VGA connection, you need to connect to an 

Bluetooth receiver - connect to 
your guitar amp with RCA audio 
cable.

Bluetooth speakers - great 
sound with no wires!

Apple TV - wirelessly project 
the screen and audio of all your 
Apple devices.

1

2 3

4



358

Music as a Second Language & The Modern Band Movement –  Little Kids Rock Teacher Manual v3.0

TE
C

H
N

O
LO

G
Y

audio source using the headphone jack of your iPad or device and 
an auxiliary cable.

Projecting Your Hands Using a 
Computer, Phone or Tablet
When teaching guitar or keys to 20-30 students, being able to show 
the entire class what your hands are doing can be very useful. You 
can use any video app on your device, or the built in camera on your 
computer to project the camera feed of your hands through your 
class projector, the classroom whiteboard or an HDTV.

❶   While connected to a projector, interactive whiteboard, or 
HDTV, open the camera app on your tablet or phone, or a 
program like QuickTime or Photo Booth on a computer. You do 
not have to press record!

❷  Point the camera toward what you would like your students to 
see, and it will show up on the screen.

 
Note: You might want a student volunteer to film you or set up 
a tripod if you are going to do this often! You can also sit you 
laptop on a secure music stand and adjust the height and angle 
accordingly. 

Creating Silent Rehearsal 
and Learning Centers  

The electric versions of Modern Band instruments are either 
silent or almost inaudible. This includes electric guitars, electric 
basses, electric keyboards, electric drum kits, computers, iPads 
and microphones! As explained in the introduction, by using silent 
rehearsal modules in conjunction with electric instruments, the 
music teacher is afforded the ability to separate his or her large 
class into small groups that can make music together without 
interrupting each other’s sound space! This is not possible with 
acoustic instruments.  Here is what you need to do it:

Headphones - It is ideal to have a combination of sound isolating 
headphones and regular headphones. The isolating ones are 
best when students are working alone or in small groups, while 
the regular ones will allow your students to hear you during 
instruction. 

Headphone Splitters - These small adapters allow you to split a 
signal up to 5 ways, allowing multiple students to plug their device 
into one source. You can use these with computers, tablets, or 
when student are sharing instruments.

JamHub Or Other Silent Rehearsal Module - The JamHub 
(www.jamhub.com) is a silent rehearsal module that allows 
multiple students to plug their instruments into it. They then 
connect headphones to it, which allows them to hear each other. 
Each student can control how much he or she hears the other 
students. This also means that two separate rehearsals can 

or

Quicktime Photobooth

Student wearing isolation 
headphones

Belkin Rockstar 5 way splitter
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Belkin Rockstar 5 way splitter

occur at the same time with one JamHub. A mixer attached to a 
headphone amp can more or less accomplish the same thing at a 
lower cost, although it requires more wires and peripheral items. 
Roland recently released a product called the HS-5 Session Mixer 
that is also a wonderful silent rehearsal module, but higher priced. 
Silent Rehearsal Modules are most practical if they can stay set up 
in one place and not be moved! Using gaffer's tape to keep wires 
in place is always a good idea! 

Guitar and Bass Amplifiers - Most entry level amplifiers, 
including all of the ones Little Kids Rock offers have a guitar 
input, an auxiliary input, and a headphone output. These can act 
as mini silent rehearsal modules, good for two people at once! 
You can hook up a keyboard to the auxiliary input, and split the 
headphone output!

Mini-Amps - Mini-amps are small pocket sized amplifiers that any 
electric instrument can plug into. They have a headphone jack so 
a student can listen to himself or herself without others hearing. 
They also have an auxiliary jack so that sound from a computer, 
device, or second instrument can be plugged into it. This allows 
students to watch a video lesson and play along, or to play along 
with a song or app. With a headphone splitter, two students can 
be plugged into one mini amp and share the headphone jack. This 
is perfect for a guitar player and keyboardist to work together. 

1/4’’ Female Mono to Male Stereo Converters - The JamHub's 
inputs are “mono” which means that you will only hear the sound 
of your instrument from the left side of your headphones. First 
plug the keyboard or guitar into a mono to stereo converter.

3.5mm (1/8”) Female Stereo to 1/4” Male Stereo Converter
Many headphone jacks on keyboards and other audio equipment 
have a large headphone jack (1/8”) that works with professional 
level headphones. To plug headphones in with a smaller jack, you 
will need this simple converter.

3.5mm (1/8”) Auxiliary Cables
These cables will connect all of your devices, and even your 
keyboards, and electronic drumsets into your modules, min-amps 
and guitar amplifiers, using headphone outputs and auxiliary or 
line inputs. Use them with the 1/4” adapter when necessary. 

Websites and Computer Programs

Google Drive and Dropbox  - If you want your 
students to view YouTube videos, either alone or 
in small groups on classroom devices, you can first 
download videos at home using KeepVid.com, and 
then upload them to Google Drive. Students will then 
be able to open them through a classroom Google 
account on any Internet enabled device. You will 
want to use a Google and Gmail account that you will 
create specifically for your music class. When you 
are in the classroom you can sign into this account 

TECH AS
TEACHING TOOL

Photo courtesy of Musical Futures Australia.

Google 
Drive
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on any device, locate your files and either view them 
on Drive, or download them to the new device. You 
can do the same thing using Dropbox. Contact us at 
program@littlekidsrock.org if you need help setting 
this up.

ClassDojo - ClassDojo is a fun way to encourage 
good behavior by awarding or subtracting points 
from a student’s personal avatar. It’s available for 
free at classdojo.com and as an app for your phone. 
Your account will automatically be synced between 
all of your devices.

Ultimateguitar.com - This website has been the 
go-to play for all guitar tablature and chords for 
many years now. The site continues to improve 
and now allows you to transpose songs to any key. 
Quality control is achieved through a rating system. 
Always select transcriptions with 5 stars! There is 
also an app to go along with it called “Tabs,” available 
in the app store.

Chromatik.com - This website allows free access to 
sheet music with chord diagrams for a vast array of 
popular songs.

HDPiano.com - This website features video piano 
tutorials for all of the most popular songs using 
the Synthesia program at its core. This is where the 
notes to be played scroll down over the keys. There 
are also some great tutorials about basic piano skills! 

Theta Music Trainer - This awesome website has 
ear training games to figure our chord progressions, 
melodies and intervals! It uses genres like reggae 
and rock while most ear training games use classical 
music. Go to http://trainer.thetamusic.com/en/
content/chord-progressions to start playing!

Apps

Guitar Tools - This is an all in one chord finder, 
scale finder, tuner, and metronome! (iOS only)

FourChords - This app allows your students to 
strum and sing along to their favorite songs! The 
words and chords are displayed on the screen in a 
way that shows you where you are supposed to be, 
and the midi tracks play the melody as a reference!
(iOS and Android)

Blob Chorus - This is an excellent ear training game 
app that will have your students listening intensely 

TECH AS
TEACHING TOOL

Chromatik.com instrument seletion screen

Theta Music Trainer chord progression 
game

Four Chords

Class Dojo tablet app
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to figure out matching pitches while also having fun!
(iOS and Android) 

Octavian - This app is the perfect companion to 
Little Kids Rock’s keyboard curriculum. It shows and 
plays you all of the chords and scales in every key in 
a way that appeals to visual learners. (iOS only)

Staff Wars - Staff Wars is both an app and a 
program for Mac and PC that looks like an old 
Atari game but will have your students fighting 
to be the next to play! As notes go by on the staff 
students either click which one it is, or play it on an 
instrument into your devices microphone! As they 
get further along the notes begin to go by faster and 
the music becomes more and more threatening!
(iOS and Android) 

Joy Tunes Piano Maestro - This is a notation based 
piano app that is constantly updated with new 
and popular songs! As the notes go by in the song, 
students try to play them correctly and in time. If 
they do, the notes light up green! It provides a fun 
way to improve piano reading skills. Hook up your 
Little Kids Rock keyboard using a USB cable! 
(iOS iPad Only)

Ultimate Guitar Tabs - The app version of the 
UltimateGuitar website. It has a very easy to use 
interface and keeps you updated on new song 
additions. (iOS and Android)

Tech as Instrument
Finding and Using Backing Tracks 
and Karaoke Tracks
Using a backing track whenever possible brings more excitement 
and relevance to musical activitie. Backing tracks can be as simple 
as a drum groove, or could be a full band showcasing a style, or a 
chord progression. Many people use them to practice improvising, 
as a songwriting tool, or just as a glorified metronome for practicing.

Karaoke tracks, on the other hand, are instrumental versions of 
published songs. When used in the classroom they can motivate 
your students to sing out to the songs they know and love, and act 
as a great bridge to a cappella singing, or singing with a real band! 
They can also help your instrumentalists learn their parts without 
having to listen past the singer’s voice!

Octavian

Staff Wars

Joy Tunes Piano Maestro
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Finding Drum Tracks
❶ Littlekidsrock.org online resources
❷  Stream or Download from YouTube. (Some YouTube 

channels that specialize in drum tracks are “Lumbeat,” and 
“FreeDrumTracks.” You can also find many genre specific 
tracks by typing in “Hip Hop Drum Track,” “Latin Drum Track,” 
or “drum play along,” etc. Once you find the one you want, 
either stream it, or download it using www.vidtomp3.com for 
audio only, or www.keepvid.com for the audio and video.

Lumbeat YouTube Channel FreeDrumTracks YouTube Channel

❸  Search on streaming apps/websites like Spotify, using similar 
search words.

❹ Search for and purchase drum tracks on iTunes.
❺   Go to drumbot.com to use their pre-made drum grooves and 

drum sequencer tool.

Drumbot.com drum groove library

Drumbot.com drum sequencer

Finding Full Band and Guitar Backing Tracks 
❶ Littlekidsrock.org online resources
❷ Stream or download from YouTube (A great YouTube 
channel specifically for guitar but still applicable to all 
instruments is “GuitarMaps.” They overlay the guitar scale or 
“map” onto the video. Other great channels for full band backing 
tracks include “BackingTrackWorld,” “JamTrackschannel,” and 
“MegaBackingTracks.” Many of these have tracks specifically for 
certain chord progressions, in many different keys!)

Little Kids Rock Build a Beat
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GuitarMaps YouTube Channel BackingTrackWorld YouTube Channel

❸  Search on streaming apps/websites like Spotify, using similar 
search words

❹ Search for and purchase drum tracks on iTunes

Websites and Computer Programs

Band-in-a-Box - This program, available for all 
platforms, allows you to create backing tracks 
using recordings of REAL award winning musicians 
in multiple genres. After generating a chord 
progression you can experiment with arrangements 
in all styles, and even record over them! You can 
then generate lead sheets, tab, notation and play 
along videos for your students! The possibilities 
are astounding! Please email us at program@
littlekidsrock.org for an exclusive promotion for Little 
Kids Rock teachers.

Incredibox.com - This simple, free and fun 
website allows students to compose and record an 
arrangement by choosing accessories for a cartoon 
man to wear. Each accessory creates a different 
sound! 

Drumbot.com - Drumbot has a library of drum 
loops with adjustable tempo to use as backing 
tracks. It also has an interactive 8 track “Drum 
Pattern Sequencer” that allows students to craft 
their own drum patterns using all parts of the set. In 
addition to this, there are interactive tools for guitar 
and piano!

Auxy - This free app is a loop based sequencer that 
allows you to create drum, bass and synth parts. It’s 
very highly rated and easy to use. (iOS only)

TECH AS
INSTRUMENT

Band-in-a-Box
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Apps

TonePad - This free app is modeled after the 
“tonematrix” on audiotool.com. Students compose 
by selecting squares in a grid that are set to different 
pitches. The electronic sounds are very modern and 
pleasing to the ears! (iOS only)
 
AmpliTube - An extremely high quality free amp 
modeling and guitar effects app that goes hand in 
hand with the iRig and iRig pro! (iOS and Android)

TF7 Synth - This free app is a polyphonic synthesizer 
for the iPad that will open up a world of creative 
possibilities! (iOS only)

Tempo - This amazing metronome app is great to 
project on a screen and hook up to a sound system 
to teach your students about beats, measures, 
tempo and even rhythmic notation values! It is a 
very cool interface that you can refer to as the “beat 
machine.” You can make the whole screen flash red 
on beat one of every measure. (iOS and Android) 

Super Metronome - This app has a library of drum 
tracks in various genres and allows you to change 
the tempo! (iOS only)

Tech for Recording
Making Informal Audio Recordings 
for Classroom Use
One of the most important aspects of learning music is the ability 
to listen, analyze and describe musical works. By using recording 
technology, you can document in class rehearsals and performances 
and play them back for reflection and discussion. If students are 
working in small groups they can use computers or portable devices 
to document their work to be shared with you or the class, or to 
record their ideas so that they will remember them next time. Just 
like how the photograph replaced the portrait artist, audio recording 
technology has made written methods of transcription lose their 
value in many circumstances. Once students know how to use these 
recording features, they can share with you at home or in class, 
through a classroom email address.

Informal Audio Recordings Using a Computer
All computers made in the past few years have an internal 
microphone. All that is required is that you open the program 
that can access it, and make a recording. A great one to use that 
is now available for Mac and PC is QuickTime. Here’s how to do 
it:

TECH AS
INSTRUMENT

TonePad Tempo

Super Metronome
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❶ Open the program “QuickTime Player”
❷ At the top, go to “File” and select “New Audio 
Recording” 
    

     

❸ Press the red button to record, and the grey square to stop

       

❹  You can either play it right away, or save it by going to “File” 
and then “Save”

  

   

Informal Audio Recordings Using the iPad
The iPad does not come with a built in audio recorder app, 
but there are plenty available for free from the app store. The 
most versatile one, that allows for editing and exporting in 
multiple file types, as well as saving files with a photograph of 
your students, is “Recorder Plus.” A simpler free app for audio 
recording is “Super Notes.”

Informal Audio Recordings Using 
IPhone or iPod Touch
The iPhone comes with an app called “Voice Memos” that takes 
great sounding audio recordings, allows trimming, pausing a 
recording, and sharing through email or text! 

To Record:
❶ Open the app and press the red button to record!
❷ Pause the recording by pressing the red square.
❸ Stop the recording by pressing “Done”
❹  The app will now prompt you to name and save your new 

recording.
❺  Once it is saved, it will go to the top of the list of recordings. 

Press it again to listen, edit, or export.

Recorder Plus

Voice Memos

Super Notes

1

4
5

2 3
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To edit:
❻  Press edit to trim the recording if you have unnecessary 

audio in the beginning or at the end. Then press the blue 
“crop” square

❼  Slide the red dots to control the start and end time of the 
recording.

To export:
❽  To export to email or text message, press the “share” button, 

which is the blue square with the arrow pointing up. 
❾  Select message or mail, and compose your email or text to 

selected recipients

Informal Audio Recordings 
Using Android Devices
The majority of Android phones and devices come with voice 
recorder apps. Here is an example of the one that comes with 
the Samsung Galaxy.

High Quality Informal Audio Recordings 
Using a Field Recorder
Field recorders are the most convenient way to capture 
high quality audio recordings of student rehearsals and 
performances. These are handheld devices that have high 
quality microphones attached and adjustable settings 
depending on the volume or room setup. Most connect to a 
computer or have a removable memory card, and some even 
double as a recording interface. Using a simple video recording 
program like iMovie or Windows Movie Maker, you can overlay 
audio from your handheld field recorder to a video of a 
performance. The results will be far better than relying on the 
audio of your phone or video camera.

Field Recorder Examples

Zoom H2N - has 4 microphones and 
records 2 tracks at the same time. After 
recording, choose which you like better.

Zoom H2N - also works as a multitrack 
recorder and an audio interface.

Android Voice Recorder App

8

6

7

9
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Making Informal Video                                        
Recordings For Classroom Use
Recording performance and rehearsal videos allows for instant 
reflection and feedback. Students can work in small groups or 
independently and video tape what they are doing for sharing or 
assessment purposes. If they are working on a dance, or playing 
something a certain way and they need to remember what their 
fingers or hands were doing, video technology will be an invaluable 
addition to your classroom!

Using Computers to Shoot Video
All Windows computers have a program called “Camera.” Macs 
have “QuickTime” and “Phot Booth.” By opening the program 
and selecting “video recording”, the image will appear on the 
screen. Use the internal camera, or attach a webcam and point it 
at your students. Open the program, and press record! 

Using iPads, iPhones, iPod Touch and Smart-
phones to Shoot Video
Sometimes the video quality on these devices is TOO GOOD! As 
explained earlier, they all default to full 1080p HD, taking up a lot 
of precious space!  A 10-minute video can take up 10% or more 
of your internal memory and this setting cannot be changed! 
Fortunately, the latest operating system (iOS 8), at the time of 
printing, is compatible with a free app called “Compressor.” This 
allows you to compress videos down to 10% of their original 
size! When picture quality is not that important, you will want 
to have this option. Android devices also have built in cameras, 
some of which have size options. If they do not, there are many 
aftermarket apps that will have this feature. 

Windows Camera App

Video Compressor 
App

Allows you to reduce 
video size by up to 90%
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How To Upload Videos to YouTube 
from iPhone, iPad, or iPod Touch

Keeping video documentation on YouTube is a great 
way to show student growth, build your professional 
portfolio, share student work within your class, share 
videos for students to see outside of school, and if you 
have permission, share with the world! Your Apple 
device will take great videos that you can easily upload to 
YouTube without your computer! Here is how:

❶  Create a YouTube account on YouTube.com using the 
sign in details of your new classroom Gmail account!

❷ Use your camera to shoot the video

❸ From your home screen, open “Photos”

❹ Find the video in your “Camera Roll” and open it

❺  Press the blue box with the arrow. This is the export 
button

❻  Select the YouTube option, fill in all the details, and 
press PUBLISH.

Audacity
Audacity is an excellent and easy to use free audio editing 
and sound recording program available to both Mac and 
Windows users! There is no “catch” – no paid version that 
you will upgrade to and the program does not limit you in 
any way. You can use this program for many purposes such 
as informal live recordings, adding effects to recordings, 
changing the pitch or tempo of a recording, and much 
more. The first step is to download the program at audacity.
soundforge.net, and install it onto your computer. In addition 
to the step-by-step print instructions below, visit our website 
for video tutorials on how to use this in the classroom.

Audacity

1

2

3
4

6

5
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❷  Choose the sound source from the microphone 
icon. You can use the built in microphone or one 
that is connected through your USB drive, or an 
audio interface.

❶ Open Audacity.

Easy 1-Step Recording with Audacity

❻    Name your recording, pick where you want it to 
save to, and choose WAV or MP3 as the format. 
(The first time you do MP3, it might ask you to 
download the “lame encoder.” Follow the easy step-
by-step directions and try again)

❹  Click the record button once to record and again to 
stop.

❸  Click on the input meters to see sound levels. Adjust 
input volume (mic icon) so that the sound does not 
reach 0 db. 

❼     It will ask you to fill out the “Metadata,” which is 
optional. Click “OK” to continue. 

❽  Locate the file in the folder it was saved to and enjoy 
your new recording!

❺  From the menu’s file tab, you can save project for 
future editing, or export to an MP3 or WAV file.
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❶    Import the MP3 song you want to edit by dragging it 
into the Audacity window. 

Changing the Pitch 

Changing the Speed of Audio Files Without Changing the Pitch
To do this is Audacity follow the same steps but instead of going to “Effect > Change Pitch,” go to 
“Effect > Change Speed! Simply enter the “percent change” you would like to make to the original 
tempo. 

Editing Songs and Recordings in Audacity
As teachers, we often need to modify songs we are working with by changing tempo, 
transposing to a new key, cutting out a section with foul language, re-arranging a song to cut 
down on its length, looping a small section, or repeating a section. All of this is easy to do in 
Audacity! Here’s how:

❺  Refer to steps 5 and 6 on the previous page to save 
your file. 

❸   On the top menu go to “effect > change pitch.” 

❷  Now we can change the pitch. “Select All”, either 
in the Edit menu or by clicking to the left of the 
waveform below its name. The background of the 
waveform should get darker when it is selected.    

❹  Choose the amount of semitones you would like to 
change it, and click “preview” to sample it or “OK” to 
save it. 
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❶    Highlight the section of music you would like to 
loop, just like you would highlight text in a word 
document.The selected area will be a darker grey 
color. 

❶    Zoom in to the waveform so that you can edit more 
precisely by going to “View > Zoom In.” You can do 
this as many times as you’d like.

Looping Parts of a Song in Playback
This means to play a small section over and over without stopping! You can slow it down, and then 
loop it in Audacity to allow your musicians to work on just a small part until they get it! Here’s how:

Rearranging Sections of a Song Using Audacity
Perhaps you want to make a four minute song into a one minute arrangement, or cut out an inappropriate verse. 
Here is how you can rearrange a song:

❷     In the top menu, go to “Transport > Loop Play.” Now, 
when you press play, only the highlighted section 
will play, and it will loop over and over!

❷    Select the section you would like to cut. Right click, 
and select “Cut” or go to “Edit > Cut”. Once you cut 
a section the areas that are left will automatically 
merge together. 

❸     If you want to paste the cut section elsewhere, click 
your cursor to the point you would like to paste it, 
right click and select “paste” or go to “Edit > Paste.”

❹    Playback your new track, save it, and export it! 
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Classroom as Recording Studio

Recording with iPads, iPhones, and 
Tablets Using External Devices 
Here are some of the essential items to turn your iOS device or 
tablet into a high-quality recording studio in conjunction with 
programs like GarageBand! Use them to plug in microphones and all 
of your electric instruments!

Camera Connection Kit/Lightning to USB Adapter - Even 
though this item has the word “Camera” in the title, it allows you 
to connect any USB device to an iPad or iPhone, such as a USB 
MIDI keyboard (the Casio model that Little Kids Rock provides), or 
a USB microphone. 

USB Microphone - The Snowball is an excellent all around USB 
mic to use with the camera connection kit and your iDevice. 
The quality will be much better than the internal microphone. It 
has three settings, making it ideal for recording speaking, loud 
singing, or a full rock band! 

iRig - The iRig attaches to the headphone jack of your iOS device 
and allows you to plug in a guitar or other instrument using a 
1/4" instrument cable! This simple and inexpensive interface will 
turn your iOS device into an amplifier and guitar effects suite! 
Students can use it just to practice and play around with guitar 
sounds or you can run the audio from the iPad to an amplifier 
using an auxiliary cable! The iRig also allows you to record 
directly into GarageBand without a microphone. It also comes 
with an app called Amplitude that has many guitar processing 
capabilities. Note: If you cannot hear the sound you are playing 
while using the iRig with GarageBand, click the “Input” icon and 
turn on “Monitoring.”

iRig Pro - The iRig Pro has many more features than the iRig 
and does everything you need to record all instruments in 
GarageBand! You can connect microphones to an XLR input, 
midi controllers into a midi input, and any instruments that use 
a 1/4" cables, such as guitars, bass guitars, electronic drums or a 
keyboard. It also provides phantom power to microphones using 
a 9 volt battery. In addition, you can use it with a computer, with 
the included USB connector!

Recording With A Computer
Although tablets and phones are the most portable recording 
devices, computers allow you to take the process to the next level! A 
professional quality multi-track recording can be made with almost 
any PC or Mac, some software, and a few peripheral devices! Here is 
what you need:

Lightning to USB 
adapter

Camera Connection 
Kit for older Apple 
devices

Blue Snowball Mic

Camera 
Connection Kit

Pro Tools, one of many DAWs.
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DAW Software (Digital Audio Workstation) - This is software 
that allows you to record, edit, and produce audio files on your 
computer. Some of the most popular ones are Logic, Pro Tools, 
Cubase, Ableton, and GarageBand.

A USB Recording Interface - In order to send audio from your 
instrument or a microphone directly into your DAW program, you 
will need a recording interface. Your instruments plug into the 
interface, and the interface plugs into your computer. These can 
be purchased for as little as $50-$100 dollars, and will be made 
available in our instrument menu to teachers that complete our 
recording workshop.

A USB Microphone - If you plan on recording with only a 
microphone, you do not need an interface. You will only need a USB 
microphone! A great and versatile entry level option that we offer is 
the Blue Snowball, but there are dozens of others on the market!

Websites and Computer Programs

Soundation.com
Soundation is a website that offers anyone with an 
internet connection a free virtual recording studio. 
You can record live instruments or vocals, add effects, 
use a library of pre-recorded loops, and then share 
your creation with the world! This is an outstanding 
resource as both a creative tool and to teach students 
how different effects and audio processes work. Access 
it for free at soundation.com!

SoundCloud.com
SoundCloud is like the YouTube for audio! Users from 
all over the world can upload their music or any other 
audio recordings to the site. Programs like GarageBand 
have an option to directly upload to SoundCloud! Little 
Kids Rock uses this site to host all of the recordings 
for our annual “Songwriting Exhibition.” The public is 
free to comment and “like” a track just like YouTube, 
although privacy can be modified. We recommend you 
create a SoundCloud account for your school as a way 
of hosting all student creations.

Apps

LoopyHD - This app became popular when it was 
featured on The Tonight Show Starring Jimmy 
Fallon with Billy Joel! It is a very simple and easy 
to use interface that allows you to record up to 12 
simultaneous loops! Your students can create ostinato 
compositions or you can use it to experiment with 
harmony, beatboxing, or putting together different 
parts of a song! (iOS only)

TECH FOR
RECORDING

TECH FOR
RECORDING

Soundation.com

LoopyHD
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GarageBand for iOS
All iPads and iOS devices now come with a free version of 
GarageBand! This is a wonderful and easy to use application 
that has many of the features of a professional recording suite! 
It also comes with an array of virtual instruments such as guitar, 
bass, drums, keyboards, synthesizers drum machines, orchestral 
instruments, and even a sampler that allows you to record sounds 
and change their pitch! You can also make use of professional 
quality pre-recorded loops from all popular music genres! Perhaps 
you want to make a backing track in which you can easily change the 
tempo and key! All of these features make GarageBand useful for all 
three categories of music technology: Tech as Teaching Tool, Tech for 
Recording, and Tech as Instrument.

Learning How To Use GarageBand
Although there are a plethora of instructional videos on the web, 
the first thing you should do when opening the app is click on the 
question mark icon. This will make descriptions of most of the 
features appear on the screen. All of the ideas below will be have 
video demonstrations at www.littlekidsrock.org in the teacher 
resources section.

GarageBand for iOS as Teaching Tool
Here are some of the uses of GarageBand for iOS as a teaching tool:

❶  Create backing tracks using virtual instruments or loops in 
any key or tempo. Change the key or tempo with the click of a 
button.

❷  Teach instruments and instrument families using pre-recorded 
loops.

❸  Teach form, tempo, key, meter, music theory.
❹  Use it as a personal amplifier in conjunction with the iRig for 

students to practice silently with headphones.
❺  Teach music terminology in an interactive way: glissando, 

arpeggio, quantization, reverb, delay, decay, treble, bass, 
cutoff, attack, sustain, waveform, dynamics, etc.

GarageBand as Instrument
By hooking up the iPad to an amplifier using an auxiliary cable, 
suddenly the GarageBand virtual instruments can be played live! 
Each virtual instrument can be played like a real one with the 
fingers, one note at a time, or you can have it set so that one finger 
plays an entire chord. In addition to this each instrument has an 
autoplay feature, so that one press of a button creates a melody 
or rhythm! There are also drum sequencers that allow students to 
create beats by dragging percussion instruments onto a grid. The 
possibilities are endless!

From top left to right: Virtual guitar, virtual 
piano, virtual drums, smart drums, virtual 
drums, and virtual bass.

TECH AS
TEACHING TOOL

TECH AS
INSTRUMENT
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GarageBand for iOS for Recording: 
Without External Devices
An entire song with an array of instruments can be created in 
GarageBand using only the built in virtual instruments, loop 
library, and the “Audio Recorder” to add vocals or acoustic sounds. 
Following is a unit of study to introduce some of these features to 
your students.

Sample GarageBand Projects
The following two projects have a corresponding instructional video 
and PowerPoint available on our website in the teacher resources 
section.

Sample Project Unit 1

A Classroom Approach to GarageBand for iOS – 
Level 1
Unit Aim: Students will learn how to edit audio clips, create 
sections, modify tempo and key, and use the audio recorder, 
culminating in the creation of a “Loop Composition.”

Day 1 Lesson 1: Open, Close, Save
Demonstrate How To:

❶ Open GarageBand. (click “+” then “Create New Song”)
❷  Start a new project (select “Audio Recorder”, then record a 5 

second “scratch track”, then go to “track view”).
❸  Save and name your project (click “My Songs,” click the name 

of song and rename).
❹ Close GarageBand.

1

2a

2b2c

3a
3b

1

3a
3b

2a

2c

3c

2b

TECH FOR
RECORDING



376

Music as a Second Language & The Modern Band Movement –  Little Kids Rock Teacher Manual v3.0

TE
C

H
N

O
LO

G
Y

Day 1 Lesson 2: Selecting Loops
Demonstrate How To:

❶ Open Track (click your song in the home screen). 
❷  Find and listen to loops from each instrument family (click 

the “rollercoaster”, select instrument, click loop titles to 
listen)

❸ Drag loops into “track area”.

2a

2b

3a
3b

2c

Day 1 Student Project – Using Loops
Students will:

•  Create a “loop” composition
•  It must have at least 4 loops
•  Your loops must come from at least 3 instrument families
•  Save your loop composition with your name, class, and a title
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Day 2 Lesson: Measures and Sections 
Demonstrate How To:

❶  Add a 16 bar B section to your existing 8 bar A section, and 
make both of them play (Click the “+” on the right side of the 
measure counter, click “add” to create a new section, click the 
“i” to change measure count).

❷  Make a C section that is a “duplicate” of your 8 bar A section 
(Select “Section A” and press “Duplicate”).

❸  View all sections or single sections (Select “All Sections” and 
then click outside of the song section area to go back to 
“Track View”).

1a

1d

2a

3a

3b

1b

1c

Day 2 Student Project: Adding Sections
Students Will:

•   Make a sandwich: Your 8 bar project will become both your A 
and C sections (the bread). 
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•   Create a 16 bar B section, choosing a new four loops from at 
least 3 instrument families (the meat).

Day 3 Lesson: Tempo, Key, Vocals
Demonstrate How To:

❶  Change the tempo of your loop project. (click the “tool 
symbol”, select “tempo”, adjust the number manually, or by 
tapping).

❷  Change the key of your loop project to best suit voice or 
other instrument. (Select “key”, choose a new key) Record 
using the “voice recorder” and headphones.

❸ Record using the “audio recorder” and headphones. (Double 
click on the vocal track you made at the start of the project, 
or select “Instruments” then choose “Audio Recorder.” Click 
the red circle to record. The measures will turn red when 
recording is in progress.)

1a
1c

1b

2a

3a

3a

2b

Day 3 Student Project: Adding Vocals
Students Will:

•  Record a vocal Part
•   Make A and C section the same. They can be either singing or 

chanting.
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•   Make the B section a rap or poem that is said in time with the 
beat.

Day 4 Lesson: Editing
Demonstrate How To:

❶   Select a clip (tap on a clip one time to select it)
❷    Zoom in on a clip (place two fingers on the screen and push 

them away from each other)
❸   Split a clip (double click on the clip and select split)
❹   Delete a clip (double click on the clip and select delete)
❺    Copy and paste a clip (double click on the clip and select 

copy, move the cursor to where you would like to paste, 
double click and select paste)

❻   Drag a clip (hold one finger down on the clip and drag it)
❼   Loop a clip (double click on the clip and select loop)
❽   Undo an action (click the backwards bending arrow)

3a

3c

6

3b

4 7

7

5a

5b

Day 4 Student Project: Switcharoo
Students Will:
•   Drag your 8 bar A and 8 bar C section vocals to become your 16 

bar B section vocals.
•   Split your 16 bar B section vocals in half and move the first half 

to the A section and the second half to the B section.
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Day 4 End of Class Lesson: Mixing
Demonstrate How To:

❶  Slide over the mixer (drag the tab in the center of the tracks 
to the right).

❷  Use the sliders (drag them to adjust volume)
❸  Use the solo function (click the headphones to hear a track 

by itself).
❹  Use the mute function (press the speaker button with a line 

through it to mute a track)

3

4

1

2

Day 4 End of Class Project Extension: Mix Your Song
Student Directions:

Take a few minutes to experiment with these functions using 
your track!
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A Classroom Approach to GarageBand for iOS – Level 2
Unit Aim: Students will learn the various ways of using virtual instruments to create and record.

Day 1 Lesson: Virtual Drums
Demonstrate How To:

❶  Use different parts of the drum (click the “?” to show all options)
❷  Adjust touch sensitivity (click the “levels” icon, then “velocity sensitivity)
❸  Merge recordings (In the levels menu, click merge recordings for automatic overdub. 

This means that the track will repeat after its over and anything you play will be added to 
original run through)

❹  Use Quantization (In the levels menu, select “quantization” and ¼ note, 1/8th note or 
1/16th note. You can also change the “Feel” to straight, swing or triplet! These options will 
neaten up poor rhythm!)

❺  Use metronome and count off (Click the tool bar to turn metronome and count off on or 
off.)

1

3

4a

4b

2b

2a

5b

5a

Day 1 Student Project: Creating a Drum Track
Students Will:
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•  Create a new project.
•   Make an 8 measure drum beat, experimenting with the different 

features!

Day 2 Lesson: Bass, Strings, Keys, Guitar
Demonstrate How To:

Play virtual Guitar, Bass, Keys and Strings 4 different ways:
❶  Like the real instrument (Select “Keyboard” from the 

instrument menu, pick the keyboard type you want)
❷  Like real instrument but within a scale (Click the “scale” 

button, and choose which scale you want. All notes 
available will be within that scale. The gray stripes are the 
root notes).

❸ One button plays a whole chord (Select “Smart Keyboard” 
in the instrument menu, press the chord you would like 
played)

❹  One button initiates an “autoplayed” chord with a different 
rhythmic pattern (click the “Autoplay” knob and try 
different options)

Note: The photos below demonstrate these options on 
keyboard, but they apply to all virtual instruments.

1a

1b

2a
2b

2c 3a

4

3b

Day 2 Student Project: Adding Instruments
Students Will:

Create three new tracks in your 8 measure drum project using 
Keys, Guitar, Bass, and/or Strings:

•   One track using the virtual version of a REAL instrument 
(Scale feature is ok to use).
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•  One track using the chord buttons and no autoplay
•  One track using the autoplay feature

Day 3 Lesson: Vocal Effects
Demonstrate How To:

❶  Use the vocal effects on the recording screen (While playing 
vocal track, click different options to sample – small room, 
dreamy, chipmunk, etc.)

❷  Access and change the reverb and echo effects in the “levels” 
menu (adjust level, and adjust type in “master effects” menu)

❸  Use the track pan feature (also in the levels menu, this 
adjusts whether the sound comes from the left or right 
speaker)

1

2a

2b

2c

2d 2e

Day 3 Student Project: Adding Vocals with Effects
Students will:

❶ Create a vocal part over their 8 bar composition.
❷ Add one effect from the record screen.
❸  Modify the reverb and echo type and level in the “levels” 

menu.
❹  Select left, right or somewhere in between for track pan.
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GarageBand for Mac
GarageBand for Mac is a fully-loaded music creation studio that 
comes free with Apple computers. Built right into it is an enormous 
sound library of pre-recorded loops that can be used for song 
composition. Preset effects for guitars and voice will instantly 
transform your sounds to something new and exciting and there is a 
built in hard-hitting library of virtual instruments with which to play 
and record your songs. You even have virtual session drummers 
to “hire” for your recording/jam sessions. Best of all, GarageBand 
keeps it easy and user friendly. Even with no experience, you can 
jump right in and be playing, recording, creating, and sharing music 
like a pro!

GarageBand Loop Library - GarageBand contains a loop 
library with hours of pre-recorded sounds for students to mix 
together to create compositions. They can also use them in 
conjunction with real instruments. Need a bass player but don’t 
have one handy? Pick one of the many bass loops and drag it 
into your project. Want a full string or horn section? It is there 
too.

Drum Loops: Hire a Pro Drummer at a Moment’s Notice  - 
GarageBand features an instrument they call “Drummer.” This 
instrument is a lifelike, realistic sounding session player that you 
can tell how you want it to play! Apple provided this amazing 
resource by hiring some of the industry’s top session drummers 
and recording engineers to create the parts. “Drummer” can 
make practice exciting by providing a dynamic and accomplished 
musician for you or your entire class to jam with. Drummer has 
players in the genres of rock, alternative, songwriter, or R&B.

Using GarageBand With an Instrument
After plugging in your guitar, microphone, or MIDI keyboard 
you’ll have a huge selection of tone pumping amps, effects, and 
instruments to use. Feeling in a Jimi Hendrix sort of mood?  Bring 
up the Woodstock Fuzz preset and get ready to set your Strat on 
fire! Record a vocal and put the Epic Diva preset on it to sound 
larger than life. For you keyboardists just plug in a Little Kids 
Rock Casio keyboard with a USB cable and access sound after 
sound of synthesizers modeled after the greats, or a variety of 
classic instruments like Bosendorfer pianos and all the traditional 
orchestral instruments you might want. 

GarageBand as Recording Studio
At its core GarageBand is a full-featured powerhouse recording 
studio. It is currently the most widely used digital recording 
workstation in the world. Like most Apple products, it was created 
with ease of use in mind. There are many simple but powerful 
recording and editing features at your fingertips that allow you to 
edit your sounds and add audio effects to finish your track like a top 
producer. For lessons on how to use GarageBand, visit the Teacher 
Resources section of www.littlekidsrock.org or explore the plethora 
of other online tutorials.
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Sharing Your Project
Students can upload their project directly to a dedicated school 
SoundCloud or YouTube account! 

Digital Audio Files Explained

Every audio and video file has a “type” or a “format.” You might see 
options on the web and in music programs to “upload an .mp3” or 
“download a .WAV file.” When you find these files on your computer, 
the “format” will be identified after the name of the song or file as 
an “extension.” An example would be “LittleKidsRockSong.mp3” or 
“LittleKidsRockSong.wav”. This is simply to denote the way that the 
digital information contained in the file was arranged. By knowing 
some of the terminology, you will be able to better understand the 
ins and outs of uploading, downloading, and editing music. 

The biggest difference between file types is their size. A WAV file that 
plays the same 3 minute song as an MP3 file can be 20 times the 
size, taking up more space on your hard drive and taking more time 
to upload and download. This is because the MP3 is “compressed.” 
The trade off is quality, but often the difference is hard to hear and 
is worth the time and space saved. Here are the common formats:

WAV and AIFF
These are the highest quality audio files and also take up the most 
space! They can be 10 times the size of a typical MP3 containing 
the same song. They are not “compressed” so there is no “loss” in 
fidelity from the original source recording. They sound identical to 
the way they were heard when recorded in a studio or on a CD. AIFF 
is specific to Apple but WAV is universal.

MP3, AAC, and WMA
These are compressed file formats that are smaller and more 
practical for everyday use. MP3 is the most common audio file type 
and the most universal. WMA is created in Microsoft programs like 
“Windows Media Player.” AAC is less common. 

File Size and Sound Quality
When you are downloading or uploading music, you might see an 
option such as 128kbps, or 192kbps, etc. This denotes the size of 
the file (kilobytes per second). We recommend that you download 
or upload to at least 192kbps as there is a noticeable loss of quality 
around 128kbps or less. See the difference in file size for a three-
minute song on the next page. 
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File Size

File Format WAV

5 MB

10 MB

15 MB

20  MB

25  MB

30  MB 30.4  MB

4.2  MB
3.5  MB 2.8  MB

1.4  MB

MP3
(192 kbps)

MP3
(160 kbps)

MP3
(128 kbps)

MP3
(64 kbps)

 
Digital Video File Types
Video files also come in many different formats that are listed 
below. The quality differences with “compression” are more 
noticeable with video since it changes the screen size and crispness. 
720p HD and 1080p HD (high definition) will be full quality, taking 
up an entire screen without losing crispness. Anything below that 
will still be expandable to full screen, but will become blurry. When 
using video to film for more informal uses, you can save space 
on your drive and time with uploading and downloading by using 
smaller sizes such as 480p! Apple’s iPhone, iPad and many Android 
devices default to full 1080p HD, taking up a lot precious space! 
There are many video apps available for download that will allow 
you to change the size.

Here are the most common video file types:

MP4 (Moving Pictures Expert Group 4)
This file type is used most often for sharing videos on the 
web. It is the preferred video type for uploading YouTube 
videos and is able to compress larger files to a smaller size 
without losing much quality!

AVI (Audio Video Interleave)
This is one of the oldest and most common formats and can 
be used by Mac, Windows and most video programs.

FLV (Flash Video Format)
This video type is used most often on websites. 
Unfortunately, they cannot be played by iPads or iPhones.

WMV (Windows Media Video)
This file type is created by Microsoft programs but is also 
compatible with many Apple programs. It is most often very 
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compressed and of low quality but small enough to send 
through an email.

MOV (Apple QuickTime Movie)
These files are native to Apple’s QuickTime but this program 
is now available as a free download for Windows users. 
These videos are very high quality and usually quite large.

Essential Music Tech Vocabulary
When dealing with a lot of cables and connections, it is important 
to know the lingo of “signal paths” (how audio, video and other 
information travels) and the many devices and connections that are 
involved.

Analog vs. Digital: In analog technology, a wave form is 
recorded and transmitted in its original state. In digital, it 
is sampled and converted into a series of numbers. Digital 
information cannot be degraded over time. Ex: A tape is analog. 
An MP3 is digital.
Clipping: When a signal puts an amplifier at max capacity, it 
“cuts” or “clips” resulting in a distorted sound. 
DAW: Digital Audio Workstation. This term is usually used to 
refer to recording programs like Logic, Pro Tools or GarageBand, 
but can also include all of the peripheral equipment used in 
conjunction with those programs. 
EQ: This is short for “equalizer” and refers to the balance 
between bass (low), treble (high) and mid (middle) frequencies. 
Gain, Volume and Level: You will often see these words used 
interchangeably but gain is an increase in power output, volume 
is an increase in decibels, and level is an increase in volume in 
relation to another sound source. 
Female and Male: A male connection plugs into a female 
connection. 
Hardware: A physical piece of equipment such as an interface, 
computer, or mixing board.
Headroom: The equivalent of having “money to burn.” It is 
when an amplifier or speaker has plenty of power left if you 
want to turn it up.
Input: A female connection that receives a signal from a male 
connection. Ex: An amplifier’s input is where the cable attaches 
from the guitar’s output.
Jack: A fixed female connection attached to a piece of hardware.
MIDI: Short for Musical Instrument Digital Interface, it is a digital 
technology that allows a wide variety of electronic musical 
instruments, computers and other devices to connect and 
communicate with one another. Our current Little Kids Rock 
keyboards have a USB MIDI output for you to connect to your 
computer!
Mono: A single channel audio signal that you will only hear from 
one speaker or headphone.
Output: A female connection that sends a signal out, when a 
male connection is plugged into it. Ex: I plugged a cable into my 
guitar's output jack.
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Pan: When you choose to put a sound in either the left side, 
right side, or center using a mixer or DAW you are panning that 
sound.
Phantom Power: You will often see this term on audio 
interfaces. Certain condenser microphones, not the kind you 
use for live singing (very sensitive ones), require extra power to 
transmit their signals. Phantom power accomplishes this task.
Plugin: An “add-on” to an existing software application, such as 
new sounds or a new feature.
Software: A digital program such as GarageBand, Microsoft 
Word, etc.
Stereo: A two channel audio signal that will play in both the left 
and right side.
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Mono T/S Connector: There are 
two connectors on this plug – the 
Tip (T) and the sleeve (S). It can 
carry one signal at a time. If you 
plug a mono-plug into a stereo 
jack you’ll only hear one side of the 
signal. This comes in three sizes – ¼ 
inch like a guitar cable, 1/8th inch 
or 3.5 mm, and 2.5mm

Stereo T/R/S Plug: There are three 
connectors on this plug – the tip (T), 
ring (R), and the sleeve (S). It carries 
the left and right channels of a stereo 
signal. This comes in three sizes – ¼ 
inch, 1/8th inch or 3.5mm like a 
headphone cable, and 2.5mm.

Instrument Cable: Use 
these mono ¼ inch cables 
to hook up your guitars, 
keyboards and bass guitars 
to an amplifier. They look 
almost identical to speaker 
cables but be sure to not use 
them for speakers. The wiring 
inside is very different. 

Speaker Cable: Use these 
mono ¼ inch cables to 
hook up speakers. They are 
usually labeled “speaker 
cable” in fine print on the 
wire. They are often thicker 
than instrument cables. Be 
sure to not use them with 
instruments.XLR or Microphone Cable: 

Commonly used to connect 
microphones to a mixer or PA 
system. Can also be used to 
connect and amplifier to a mixer or 
a speaker to an amplifier.

VGA Cable: Carries analog video 
information from a computer to a 
monitor. Can also connect to LCD 
projectors, and many flat screen 
televisions.

Apple Thunderbolt Connection: 
Used as a data and video output 
on Mac computers for the past few 
years. Typically used as a video 
adapter for macs connecting to an 
HDMI or VGA connector. Can also 
be used for hard drives, Ethernet, 
or other peripheral connection, 
with the right adapter.

Micro USB: Used to connect a 
small peripheral device like a phone 
or camera into a computer or 
charging port.

MIDI Cable: This cables connects 
a MIDI controller to a computer or 
MIDI processor.

USB A: Computer or power side 
plug. Used to carry data from a 
computer or device to another 
computer or device, such as an 
external hard drive, printer, phone, 
audio interface, etc. 

RCA Audio Cable: Use this to 
connect a device’s RCA audio 
output to another devices RCA 
audio input.

Apple 30 Pin Connection: 
Used to power an older 
iPhone/iPad or iPad or to use 
as a video or data output for 
these devices.

Mini USB: Used to connect 
a small peripheral device like 
a phone or camera into a 
computer or charging port.

HDMI Cable: Used to 
connect digital audio/
video devices together, for 
example, connecting your 
Apple TV or DVD player to 
your T.V. This single cable 
carries both digital audio 
and video signals.

RCA Composite Cables: The red and 
white cables carry left and right audio 
channels, and the yellow carries 
video. The three cables are identical, 
just color coded for convenience. If 
you needed to connect a DVD player 
to a TV and didn’t have a yellow cable, 
you could connect it with another 
color as long as you were connecting 
video output to video input.

Apple Lightning 
Connection: Used to power 
an iPhone/iPod or iPad or to 
use as a video or data output 
for these devices.

USB B: Used as an output on 
a device such as a computer, 
printer or hard drive to 
transfer data to a computer 
or other device.

Speakon Connector: Used 
to connect speakers to 
amplifiers.

3.5mm (1/8th inch) Auxiliary 
Audio Cable: Use these to 
connect your phone, tablet or 
computer’s headphone jack to 
a speaker, amplifier or other 
device’s “aux” input.

RCA to 3.5mm (1/8th inch) Auxiliary Audio 
Cable: Use these to connect your phone, tablet or 
computer’s headphone jack to a speaker, amplifier 
or other device’s red and white RCA audio input.

Direct Box: Allows you to 
connect a ¼ inch cable to 
an XLR input. For example, 
connecting an acoustic guitar 
to a mixer. Comes in passive 
(unpowered) and active 
(needs batteries or to be 
plugged in) varieties.
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